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License Agreement 
 

 

SINGLE COPY SOFTWARE LICENSE 

 

THIS IS A SINGLE COPY SOFTWARE LICENSE granted by MinServ (Mineral 

Services), (the "Company").  The Software is licensed to you as the end user. It is not 

sold. 

 

1. The Software enclosed in this package is copyrighted material. Once you have 

paid the required single copy license fee, you may use the Software for as long as you 

like provided you do not violate the copyright and if you follow these simple rules: 

 

(a) You may use the Software on any computer for which it is designed so long as not 

more than one (1) person uses it at any one time. You must pay for additional copies 

of the Software if more than one (1) person will be using it at the same time on one (1) 

or more computers. 

 

(b) The Software is copy protected. You may make no more than one (1) copy of the 

Software for backup purposes, and all such copies, together with the originals, must 

be kept in your possession or control. You may only transfer the Software to another 

user if you transfer the originals and all copies retaining no copies for yourself. 

 

(c) You may not make any changes or modifications to the Software, and you may not 

decompile, disassemble, or otherwise reverse engineer the Software. You may not 

rent or lease it to others. You may not use it on a computer network unless only one 

(1) person can use it at a time. 

 

(d) If this copy of the Software is an update to an earlier version of the Software, it is 

provided to you on an exchange basis. The acceptance of an updated copy of the 

Software shall result in the voluntary termination of your earlier License and of all 

rights to use or transfer the earlier version of the Software to another. 

 

2. Use of this Software for business solicitations and/or mailings of any kind may 

be contrary to the laws of Australia or other governments, or the rules and regulations 
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of certain governing bodies, and the Company disclaims any liability for any improper 

use or misuse of the Software. 

 

3. In no case shall the Company's liability exceed the price paid for the product 

and for the license fee to use the Software. 

 

4. This License constitutes the entire agreement and understanding between the 

parties and supersedes any prior agreement or understanding whether oral or written, 

relating to the subject of this License. This License may only be modified by a written 

agreement signed by the Company. 
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Introduction 

 

About XRDCalc 

XRDCalc is a Windows powder diffraction utility for identifying phases, calculating and 

plotting powder diffraction data. XRDCalc calculates d-spacings and two-theta and 

plots digital scan files, two-theta or d-spacing vs intensity stick plots and peak profiles. 

XRDCalc Features 

Built in Spreadsheet 

 

   XRDCalc has an inbuilt spreadsheet with clipboard support for entering and editing 

peak data. 

 

Builtin Mineral XRD Database 

    

   A builtin Mineral XRD Database contains the strongest three d-spacings for all 

minerals.  The database can be searched by mineral name or d-spacing. 

 

Plot Digital Scan Files 

 

Import and plot ASCII, RRuff (*.rruff),  Sietronics (*.cpi), dbw type (*.dat) and 

Scanpi(*.dat) digital scan files.  Perform search/match and quantitative analysis on the 

plots. 

 

XRD Peak Plots 

 

   Select from two-theta vs intensity or d-spacing vs intensity stick plots or curve plots.  

A choice of labels and titles are available to customize the XRD.  Labels can be placed 

on any number of peaks.  Prevent crowding of data by selecting extra wide XRD’s. 

 

   On screen control includes data sensitive peaks so that each peak of the XRD is 
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related to a particular set of data listed within a spreadsheet. 

 

Data Manipulation 

    

   Data can be sorted numerically or alphabetically.  Both way conversions between 

two-theta and d-spacing are available with a click of the mouse.  Calculations can be 

solved using any wavelengths.  When two-theta for a particular wavelength is 

unknown, a solution using known d-spacings can be obtained. 

 

Printing 

 

   Graphs can be customized with a choice of labels and titles.  Data can be printed in 

a list or exported into a spreadsheet package. 

About X-Ray Diffraction 

 

   X-ray diffraction is a method for analyzing the crystal structure of crystalline 

materials.  It is in widespread use to identify crystalline materials that are difficult to 

characterize using other methods.   Minerals, metals, alloys and organic molecules are 

the main materials analyzed.  Some subjects that employ this method are materials 

science, mineralogy, physics, chemistry and metallurgy.  The mining and chemical 

industries have routinely adopted this method of analysis. 

 

   X-ray diffraction depends upon the principle of diffraction to indirectly measure the 

spacings (d-spacings) between lattice planes within crystals.  Typically, x-rays of a 

specific wavelength are passed through a powdered sample mounted on a glass 

plate.  Since the lattice planes are at the appropriate spacing to diffract certain 

wavelengths of x-rays, each diffracted beam corresponding to a specific d-spacing can 

be measured.  The measured value can then be matched to reference values to 

identify the crystal. 

 

   With a powder diffractometer, x-rays are directed through a powdered sample that is 

rotated through an angle .  The detector is rotated through 2 on the same axis and 

measures intensities and 2 angles of  the diffracted rays.  Output is plotted via  a strip 

chart recorder or recorded and processed using a microcomputer system and 
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appropriate software. 

 

   A monochromatic beam of x-rays hits the powdered sample at an angle  and the 

grating effect results in scattering.  There is only one angle that satisfies Braggs Law 

and at which mirror reflection of the incident beam occurs for a specific d-spacing.  At 

this angle, reflected waves from adjacent hkl planes are in phase and have a 

measurable intensity.  The intensity and geometry of x-rays diffracted by a crystal are 

affected by the properties and arrangement (particularly the electronic configurations) 

of the constituent atoms.  D-spacings are calculated from the two-theta angles using 

Braggs Law.  From the geometry of x-ray diffraction, Braggs Law is obtained 

 

n = 2 dhkl Sin         where: 

n = an integer equal to the diffracting lattice plane  

 = wavelength of radiation 

d = d-spacing.  The spacing between adjacent 

hkl planes 

 = angle the incident and reflected beams make 

with the lattice plane hkl 

2 = two-theta.  The angle between incident 

and diffracted beams 

 

 

 

 

 

Getting Started 

 

   XRDCalc requires a minimum system configuration for effective results.  The system 

requirements are: 

 

  Windows 2000, XP, Vista, Windows 7 
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  Internet Explorer 6 SP1   

  Devices supported by Windows 

  Printer supported by Windows 

 

For automatic installation, proceed as follows: 

 

CD SETUP: 

1. Go to the Run Option on the Start Menu and Select Browse 

2. Open (CDROM)D:\Disk1\Setup.exe to Setup XRDCalc  

3. Setup will start. You should not have any problems, but if you do have problems, 

you may need to install the latest service pack for your Windows to update system 

files. Service packs are available from the Microsoft Windows Update Site, 

http://windowsupdate.microsoft.com/ 

4. Setup will start and copy the program files to the PC’s Hard Disk 

5. After Setup has concluded, you will get a [App] Setup was Completed Successfully 

message. 

6. To Start XRDCalc, go to the XRDCalc Menu and click on XRDCalc.  Enter your 

registration details in the Registration Window. 

7. IMPORTANT: We recommend using the online help, and hardcopy manual to 
learn more about XRDCalc.  Installation will now proceed.  During installation, the 
user is prompted for a directory.  If this is ignored, a new directory called XRDCalc 
will be created.  If a directory path is entered, a new directory with this name will be 
created.  The user will be notified when installation is complete.  A new Menu Item 
containing XRDCalc and XRDCalc HELP is created.  Click on XRDCalc to start the 
program. 

 

http://windowsupdate.microsoft.com/
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Tutorial 

Introduction 

 

 Sample data files are provided for initial use with the program.  To load a sample 

peak data file, click  Open from the File menu and select rhyolite.xrc in the xrdcalc.exe 

directory.  To load a digital scan file, select Plot Scan File and Click on the Browse 

Button next to the Filename Box.  Select one of the *.cpi files in the xrdcalc.exe 

directory to plot or use your own file.  If help is required, press F1 to access online help 

.  Alternatively, pull down the Help menu and select Contents. 

Getting To Know XRDCalc 

 

   To load the rhyolite.xrc data file, click the Open command button or select Open 

from the File menu.  The Open dialog box will pop up.  Select rhyolite.xrc in the 

directory containing xrdcalc.exe.  If no directory was specified by the user during 

installation, the default directory name is XRDCalc 

 

   

 Before proceeding with a calculation, the correct radiation must be set by the user.  

Pull down the Calc menu and select Set Wavelength.  A value can be entered in the 

edit area of the list box or selected from the list.  Choose CoKa from the list and click 

OK to accept the wavelength and return to the spreadsheet.  The selected wavelength 

is displayed in the bottom left hand corner of the spreadsheet.  Pull down the Calc 

menu and click the d-spacing command to calculate d-spacings from two-theta. 

 

Hint: 

               Use the Calc button as a shortcut to calculate data.  The default 

calculation for Calc is d-spacings.  To change the default setting, select a 

new calculation (two-theta or d-spacings) from the Calc menu.  
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Entering Peak Data 

 

   Select New from the File menu to start a new data file.  Data is entered in each cell 

by simply typing the value and pressing <enter>.  Use the scroll bars, arrow, page up 

and page down keys to navigate through the spreadsheet.  To edit a cell, press 

<enter> for the cell you want to edit and use the backspace/delete/insert keys to edit 

the text.  When finished editing press <enter> the new value will appear in the 

spreadsheet.  Whole rows can be inserted and deleted using the Insert Row and 

Delete Row command buttons.  Blank lines are not permitted between data.  Similarly, 

blank or zero values mixed with two-theta or d-spacing data will produce errors in the 

calculation. 

 

   Enter the following data: 

 

Two-theta D-spacing Intensity Crystal Name 

 

26.66 3.34 100 Quartz 

28.14 3.17 45 Plagioclase 

8.77 10.1 38 Biotite 

29.47 3.03 55 Calcite 

 

   To edit a cell, go back to Row 2, Col 3 and press <enter>.  Type 42 to replace 45 

and press <enter>. 

 

    When you have finished using the program, select Exit from the File menu. 

Plotting Peak Data 

 

   Click the Set XRD Options command in the Options menu.  A new window will 

display several options.  Accept the default values and click the Plot button.  A XRD of 

two-theta vs intensity will appear on a new form.  To plot a label, Click row #3 in the 

grid list.  This row and its corresponding peak on the XRD will now be highlighted.  

Click on two-theta in the labels list to the left of the grid and a  two-theta label will be 

displayed.  Try different labels. All labels can be deleted by selecting clear labels on 

the labels list.  When finished, click the OK button and you will be returned to the 
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Options window.   

 

   Select two theta in the Set Labels menu and manual in the Scale Type menu.  Enter 

20 for Xmin and 45 for XMax.  Enter an XRD title and click the Plot button.  A new 

XRD with the selected scale and labels is displayed.  Labels created are automatically 

printed with the XRD when Print XRD is selected.  To return to the spreadsheet click 

OK in the Plot and Options screens. 

 

Plotting a Digital Scan File 

 

  To plot a digital scan file, a scan file must be open in the spreadsheet or Plot Scan 

Options Window. To open a scan file, import a file using the Import Command. There 

are several different file formats supported by XRDCalc, including text files. Other file 

formats can be imported using the ConvX application supplied with XRDCalc and 

accessed with the Convert Command. For this exercise, select one of the Sietronics 

scan files (*.cpi) in the default XRDCalc.exe directory. 

 

  Once imported, select Plot Scan File from the Options Menu. The Plot Scan Options 

Window will appear. Select Plot From Spreadsheet and click on the Plot Button. The 

scan file should now be plotted. 

 

Alternatively, a file can be opened directly from the Plot Scan Options Window by 

clicking on the Browse Button and selecting one of the supported files. A radiation can 

be entered for files that do not contain this information. It is much faster to plot a file 

directly from disk rather than using the spreadsheet. Once the scan file is plotted, 

peaks can be extracted and search/match can be performed. 

Hint: 

               Use the mouse to navigate through the spreadsheet.  Click a cell to 

change the current cell or click on the scroll bars to display out of view data.  

To begin editing a cell, double click the mouse.  
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Performing a Search/Match 

 

Auto Search Match 

 

   This option performs a Search/Match of the builtin mineral database using the digital 

scan file in the current spreadsheet or Plot Window.  All peak filtering is done 

automatically, no manual adjustment of settings is necessary. A list of matches will be 

returned to the spreadsheet under the Name column. During the Search/Match, if the 

three strongest d-spacings are found, the mineral will be returned as a match.  If no 

matches are found please check the following: 

 

1. The correct radiation has been entered in the Set Wavelength Option 

2.   The spreadsheet columns are defined correctly in the Define Columns Option 

3.    D-spacing and Two-theta are formatted correctly in the Format Option 

 

   Use the Accurate Match Option in most cases. This will search the peak file for d1, 

d2 and d3. This option gives the best results.  If you get zero likely matches, use the 

Expanded Match Option which searches the peak file for d1, d2 and d3, but also 

doubles the search width.  This option will give the most matches, but beware, it will 

most often give false matches. If no likely matches are found, a manual search/match 

will probably be required. The Auto Search/Match Option may give a large number of 

matches. If no likely matches are found, a manual search/match will probably be 

required using the filters available and specifying a wider search range for d-spacings. 

A manual search/match can be performed following the auto search/match to further 

refine the search. 

 

Hint: 

               If an error occurs during a calculation or while plotting data, the 

most likely cause is incorrect data.  Check for zero or blank data values.  

Mixed numeric and non-numeric data will also produce errors.  
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Manual Search/Match 

 

   This option performs a Search/Match of the builtin mineral database using the peaks 

in the current spreadsheet or Plot Window. This should only be performed on 

extracted peaks, or after the auto search/match. 

 

1. Extract peaks, for example peaks > 5% intensity 

2. Remove overlapping shoulder peaks with Refine Peaks 

3. The result will be a peak file with discrete peaks 

 

If the peaks have been read directly from a chart and entered into the spreadsheet, 

the previous 3 steps are not necessary. If the auto search/match has already been 

performed, the extracted peaks should already be displayed, the previous 3 steps are 

not necessary. 

 

  Specify a d-spacing search range for performing the search. All minerals matching 

the peak within this search range will be classified as a match. The wider the search 

range, the more matches obtained. A list of matches will be returned to the 

spreadsheet under the Name column. During the Search/Match, if the three strongest 

d-spacings are found, the mineral will be returned as a match. Some manual 

refinement of the results may be required. If no matches are found please check the 

following:  

 

1. The correct radiation has been entered in the Set Wavelength Option 

2.  The spreadsheet columns are defined correctly in the Define Columns Option 

3.    D-spacing and Two-theta are formatted correctly in the Format Option 

 

   Use the Accurate Match Option in most cases. This searches the peak file for d1, d2 

and d3. This option gives the best results. If you get zero matches, try widening your 

search. If you continue to get zero likely matches, use the Expanded Match Option. 

This searches the peak file for any peak that matches d1, d2 or d3, but beware, it will 

most often give false matches. 

Backing Up Databases 
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  The Mineral XRD Database is editable. Any changes to the database are saved to 

the database; however, it is highly recommended, the XRD Database is backed up 

periodically. The easiest way to do this is to copy the database file, xray.mdb, to a 

backup folder of your choice using Windows Explorer or My Computer File Manager. 
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XRDCalc Menu System 

 

Introduction 

 

  When XRDCalc is started the first screen displayed contains a spreadsheet and 

menu system.  The menu system provides access to all the features of XRDCalc.  

Standard Windows menu items; such as, File, Edit and Help are included.  Other 

menu items provide access to the specialized features of XRDCalc. 

File Menu 

 

   The File Menu provides many standard file management options. 

 

New Command 

 

   Deletes data in the current spreadsheet to begin a new file 

 

Open Command 

 

   Provides access to the Open dialog box.  Opens a new file.  Select the directory and 

file and click OK.  A file can also be opened by clicking the Open command button. 

The Open Command is for opening XRDCalc peak files (*.xrc) 

 

Import Command 

 

XRDCalc can import the following digital scan files: 

 

RRuff *.rruff 

Sietronics *.cpi 

DBW Type *.dat 

ScanPI Type *.dat  
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Other file types can be plotted by using the file conversion utility in the File Menu or by 

importing a raw file into the spreadsheet and plotting directly from the spreadsheet. 

 

Import Text File Command 

 

   Imports a text file.  Select the type of file to import: 

Space Delimited 

Comma Delimited 

Tab Delimited 

Semi Colon Delimited 

Fixed Width 

Specify the number of lines to skip at the beginning of the file to avoid importation of 

file headings into the spreadsheet. 

 

Convert Command 

 

Opens the ConvX application by M. Bowden, New Zealand. ConvX converts many 

powder diffraction file formats. Distributed with permission.  

 

Save Command 

 

   Saves a file to disk.  The default filename is the current filename.  The same result is 

obtained by clicking the Save command button. 

 

Save As Command 

 

   Saves a file to disk in a directory and filename specified by the user.  A Save As 

dialog box pops up for the user to enter filename and directory path information. 

 

 Print Command 

 

   Prints a data file.  A Print dialog box pops up.  Select Print to print the file. The same 

result is obtained by clicking the Print command button. 

 

 

Print Setup Command 
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   Specifies printer settings available to the user.  A Print Setup dialog box pops up 

with several options to control the printer.  Use this option to set the default printer and 

various printer settings. 

 

Exit Command 

 

   Quits the application. 

Edit Menu 

 

   The Edit Menu provides access to several standard commands for editing the 

spreadsheet. 

 

Copy Command 

 

   Copies selected text in the spreadsheet to the clipboard without deleting.  Highlight 

the text to be copied by dragging the mouse or holding down the shift key and clicking 

cells.  Highlighted text must be contiguous.  Select Copy to copy the selected text to 

the clipboard.  Use Paste to paste text from the clipboard to the spreadsheet.  Use Cut 

to remove highlighted text from the spreadsheet to the clipboard. 

 

Cut Command 

 

   Copies selected text from the spreadsheet to the clipboard and clears the 

highlighted area in the spreadsheet.  Highlight text to be cut by dragging the mouse or 

holding down the shift key and clicking cells.  Select Cut from the edit menu to transfer 

selected text to the clipboard.  Use Paste to retrieve cut text from the clipboard.  Use 

Copy when you want to copy text to the clipboard without deleting the highlighted text. 

 

Paste Command 

 

   Retrieves text from the clipboard and pastes it into selected cells.  Highlight cells that 

are to receive the incoming text by dragging the mouse or holding down the shift key 

and clicking cells.  Highlighted cells must be contiguous.  Select Paste from the Edit 
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menu to transfer text from the clipboard to the spreadsheet..  Any text that already 

exists in the highlighted cells will be replaced.  If the number of selected cells are 

fewer than will hold the clipboard text, the rightmost text from the clipboard will be 

truncated to fit the selected cells.  If the number of cells selected exceed the length of 

the clipboard text, the remaining cells will be cleared.  Use Copy and Cut to send text 

to the clipboard. 

Search Menu 

 

    The Search Menu allows the user to find and replace user specified text. 

 

Find Command 

 

   Finds a user specified search text in the spreadsheet.  A pop up Search/Replace 

dialog box prompts the user for the search text.  Enter the exact search text and click 

OK to proceed with the search. 

 

Repeat Find Command 

 

   Repeats a search using the previous specified search text. 

 

Replace Command 

 

   Finds a user specified search text and replaces it with a user specified replace text.  

A pop up dialog box prompts the user for search text (Find What) and replacement 

text (Replace With).  The following options are available: 

 

             Replace- replace the first occurrence of the search text 

                      with the specified replace text 

 

             Replace All - replace all occurrences of the search text 

                           with the specified replace text. 

Sort Menu 
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   The Sort Menu allows the user to sort data in the spreadsheet according to 

two-theta, d-spacing, intensity or crystal name. 

 

Two-theta Command 

 

   Sorts data in the spreadsheet into increasing numerical order by two-theta value. 

 

d-spacing Command 

 

   Sorts data in the spreadsheet into increasing numerical order by d-spacing value. 

 

Intensity Command 

 

   Sorts data in the spreadsheet into decreasing numerical order by intensity. 

 

Crystal Name Command 

 

   Sorts data in the spreadsheet into alphabetical order by crystal name. 

 

Calc Menu 

 

   The Calc Menu permits the user calculate two-theta values from d-spacings or 

d-spacing values from two-theta.  The wavelength used in the calculation can be 

specified by the user. 

 

2-theta Command 

 

   Calculates two-theta values from d-spacings.  The correct radiation used in the 

calculation must be set by the user with the Set Wavelength command.  Blank or zero 

d-spacing values mixed with data will produce an error in the calculation.  If the 2-theta 

command has a check mark, the calculation can also be activated by clicking the Calc 

command button. 

 

d-spacings Command 
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   Calculates d-spacings from two-theta values.  The correct wavelength used in the 

calculation must be set by the user with the Set Wavelength command.  Blank or zero 

two-theta values mixed with data will produce an error in the calculation.  If the 

d-spacings command has a check mark, the calculation can also be activated by 

clicking the Calc command button. 

 

Database Menu 

 

   The Database Menu provides access to the builtin Mineral XRD Database or an 

external database specified by the user.  The builtin Mineral XRD Database contains 

the strongest three d-spacings and mineral name for all minerals.  From the Database 

Window a simple search can be performed and the results printed. 

Backing Up Databases 

 

   The Mineral XRD Database is editable. Any changes to the database are saved to 

the database; however, it is highly recommended, the XRD Database is backed up 

periodically. The easiest way to do this is to copy the database file, xray.mdb, to a 

backup folder of your choice using Windows Explorer or My Computer File Manager. 

Mineral XRD Database Window 

 

The Mineral XRD Database is editable. To enable editing, goto the Edit Menu and 

select Enable. 

 

A search can be performed on the database using the search text entered and clicking 

on search. There are several user definable options for performing searches, including 

searching specific fields and numeric d-spacing searches. 

Options Menu 

 

Set XRD Options Command 
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   Accesses the Options Window to select the XRD settings prior to plotting. 

 

Colors Command 

 

   Provides access to the Colors dialog box for selecting the plotting Colors and line 

styles.  Select a number or click on the Color or linestyle to place the corresponding 

code number in the spreadsheet. 

 

Assign Colors Command 

 

   Automatically assigns a Color to each crystal and places the appropriate Colour 

code into the spreadsheet.  Crystal names must be entered into the spreadsheet for 

this option in order to identify each component. 

 

Auto Color Command 

 

   If this option is checked, Colors are automatically calculated for each component 

and plotted with the stick plot.  Crystal names must be entered into the spreadsheet 

for this option to work properly. 

 

Format Command 

 

   This command opens the format dialog to set numeric formatting of d-spacing and 

two-theta.  Enter the number of decimal places to round d-spacing or two-theta.  

Select Save to save the formatting information without formatting the data or Format to 

format the data immediately. 

 

Insert Column Headings Command 

 

   Select this option to insert standard column headings into the spreadsheet.  Column 

headings will be placed in Row 1 and in the columns set with the Define Columns 

command.  D-Spacing, Intensity, Two-Theta and Crystal Name headings are inserted. 

 

Intensity to Percentage Command 

 

   Converts intensity values that have been read from the powder diffractometer as 
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counts to percentage.  Enter the upper intensity limit of the data and click on calculate 

to convert. 

 

Extract Peaks Command 

 

  Extracts peak intensities and two-theta values above a specified intensity  from 2-

theta/Intensity digital scan files.  

 

  Typically, extracting peaks is a two part process.  Peaks are first extracted from the 

scan file using the Extract Peaks Option.  This creates a new spreadsheet or table 

with extracted peaks.  There will be many shoulder peaks from the initial scan file and 

it is necessary to Refine and Filter the Peaks to obtain a final peak file.  Use the Refine 

Peaks Option to filter out shoulder peaks. 

 

Refine Peaks Command 

 

  This option removes adjacent shoulder peaks from the digital scan file.  Specify a 

range for adjacent peaks and all adjacent peaks within this range will be deleted.  Use 

the recommended values if you are unsure which values to use.  Typically, extracting 

peaks is a two part process.  Peaks are first extracted from the scan file using the 

Extract Peaks Option to extract peaks above a specified intensity value.  This creates 

a new spreadsheet with extracted peaks.  There will be many adjacent shoulder peaks 

from the initial scan file and it is necessary to Refine and Filter the Peaks to obtain a 

final peak file.  Use the Refine Peaks Option to filter out adjacent shoulder peaks. 

Once the peaks have been extracted and filtered, a Search/Match can be performed.  

You should aim to obtain the strongest 12 peaks for multiphase samples and the 

strongest 4 peaks for single phase samples, in order to perform a search/match. 

 

Search/Match Command 

 

   This option performs a Search/Match of the builtin mineral database using the peaks 

in the current spreadsheet or Plot Window. This should only be performed on 

extracted peaks, or after the auto search/match. 

  If the peaks have been read directly from a chart and entered into the spreadsheet, 

the following 3 steps are not necessary.. If the auto search/match has already been 

performed, the extracted peaks should already be displayed, the following 3 steps are 
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not necessary. 

 

 

4. Extract peaks, for example peaks > 5% intensity 

5. Remove overlapping shoulder peaks with Refine Peaks 

6. The result will be a peak file with discrete peaks 

 

     Specify a d-spacing search range for performing the search. All minerals matching 

the peak within this search range will be classified as a match. The wider the search 

range, the more matches obtained. A list of matches will be returned to the 

spreadsheet under the Name column. During the Search/Match, if the three strongest 

d-spacings are found, the mineral will be returned as a match. Some manual 

refinement of the results may be required. If no matches are found please check the 

following:  

 

1. The correct radiation has been entered in the Set Wavelength Option 

2.  The spreadsheet columns are defined correctly in the Define Columns Option 

3.   D-spacing and Two-theta are formatted correctly in the Format Option 

 

   Use the Accurate Match Option in most cases. This searches the peak file for d1, d2 

and d3. This option gives the best results. If you get zero matches, try widening your 

search. If you continue to get zero likely matches, use the Expanded Match Option. 

This searches the peak file for any peak that matches d1, d2 or d3, but beware, it will 

most often give false matches. 

 

Auto Search/Match Command 

 

    This option performs a Search/Match of the builtin mineral database using the 

digital scan file in the current spreadsheet or Plot Window. All peak filtering is done 

automatically, no manual adjustment of settings is necessary. A list of matches will be 

returned to the spreadsheet under the Name column. During the Search/Match, if the 

three strongest d-spacings are found, the mineral will be returned as a match. If no 

matches are found please check the following: 

 

1. The correct radiation has been entered in the Set Wavelength Option 

2.  The spreadsheet columns are defined correctly in the Define Columns Option 
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3.    D-spacing and Two-theta are formatted correctly in the Format Option 

 

   Use the Accurate Match Option in most cases. This searches the peak file for of d1, 

d2 and d3. If you get zero matches, try using the Expanded Match Option. This 

searches the peak file for d1, d2 and d3, but also doubles the search width. This 

option will give the most matches, but beware, it will most often give false matches. If 

no likely matches are found, a manual search/match will probably be required using 

the filters available and specifying a wider search range for d-spacings. A manual 

search/match can be performed following the auto search/match to further refine the 

search. 

 

Search Mineral From Database 

 

   Performs a search of all peaks listed in the Plot Window Data Table and returns a 

match if all three mineral values match the peak values. Select a mineral from the 

database to search for and specify a range. All peaks that fall within the specified 

range are returned as a match. 

 

Define Columns Command 

 

   When a data file in a different format is imported , columns containing d-spacing, 

intensity, two-theta, crystal name and/or Color must be defined using this command so 

that the calculations and plotting will be performed correctly.  Minimum requirements 

are d-spacing and intensity.  Enter a column number between 1 and 8 in the Define 

Columns dialog box that corresponds to the data type.  Empty columns can be 

assigned to two-theta, crystal name and Color if no data is available or these can be 

left blank in the Define Columns dialog box.  If your data file contains additional data, it 

will still be displayed intact and all spreadsheet functions will work. 

 

Set Wavelength Command 

 

   Sets the radiation and wavelength used in the d-spacings and two-theta calculations.  

A pop up dialog box appears with a list of radiations.  A value can be selected from the 

list by clicking a value with the mouse or entered via the keyboard in the edit window 

of the list box.  Several options are displayed: 
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 OK - accepts the radiation displayed in the edit window 

 and exits the dialog box. 

 

 Add - adds the radiation displayed or entered in the 

 edit window to the list box. 

 

 Delete -  deletes the radiation highlighted in the 

 list area of the list box.  Highlight the 

 radiation to be deleted then select delete. 

 

   Radiation must be entered in a specific format.  A straight numerical value is 

acceptable.  Alpha-numeric text with an "=" identifier preceding the numerical part is 

also acceptable e.g.: 

 

 1.5418       valid 

 CuKa=1.5418      valid 

 CuKa1=1.5418      valid 

 CuKa 1.5418      invalid 

 

 

Plot Menu 

 

Plot Command 

 

   Accesses the Options Window to select the XRD settings prior to plotting peak data.  

The same result is obtained by clicking the Plot command button. 

 

Plot Scan Command 

 

   Accesses the Plot Scan File Options Window to select the plotting settings prior to 

plotting a digital scan file 
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The Spreadsheet 

 

Introduction 

 

   A spreadsheet is a form consisting of rows and columns of data and is the best 

method for displaying and manipulating data in row and column format.  The custom 

spreadsheet supplied with XRDCalc is used for entering and editing data.  Once the 

data is correctly entered, data can be sorted, calculated and plotted. 

 

 

 

File Formats  

 

 XRDCalc can import the following digital scan files: 

 

RRuff  *.rruff 

Sietronics *.cpi 
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DBW Type *.dat 

ScanPI Type *.dat  

 

  Other file types can be plotted by using the file conversion utility in the File Menu or 

by importing a raw file into the spreadsheet and plotting directly from the spreadsheet. 

  

  The built in spreadsheet reads and writes data files in tab delimited ASCII format.  

This format is used by Microsoft Excel and is compatible with most spreadsheets.  

ASCII is short for American Standard Code for Information Exchange.  ASCII files 

contain standard text without hidden characters.  A tab delimited ASCII file is a text file 

with each field separated by a tab character and each line by a carriage return.  

XRDCalc files with the .xrc or .dat extension are tab delimited ASCII files.  XRDCalc 

uses files containing data only with the first row reserved for column headings.   Files 

containing any extra information; such as titles, heading information and row numbers 

will require editing before they can be used with XRDCalc. 

 

The built in spreadsheet requires data to be in a specific format for plotting and 

converting. XRDCalc uses a custom *.xrc file format.  Tab delimited ASCII files can be 

imported using Import in the File Menu.  Imported files are displayed intact. In order to 

use XRDCalc’s features it is necessary to correctly define which columns contain d-

spacings, two-theta, intensity, crystal name and color with the Define Columns 

command.  As a minimum, XRDCalc requires d-spacing and intensity values to work.  

If no data exists for some headings, leave the column value defined in the Define 

Columns Window blank or set to zero or assign an empty spreadsheet column.  

Additional data can be entered via the keyboard or using the clipboard. 

 

   Graphs created with XRDCalc can be saved as graphics files for exporting into paint 

programs, word processors and other applications.   Graphs can be saved in the 

following formats: 

 

                                  1.  bitmap (*.bmp) 

 

   Select Save XRD As from the plot menu and enter the filename with the appropriate 

graphics extension. 
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Entering Data 

 

      Data is entered in each cell by simply typing the value and pressing <enter>.  Use 

the scroll bars, arrow, page up and page down keys to navigate through the 

spreadsheet.  Use the scroll bars when moving around the spreadsheet.  To edit a 

cell, press <enter> for the cell you want to edit and use the backspace/delete/insert 

keys to edit the text.  When finished editing press <enter> the new value will appear in 

the spreadsheet.  Whole rows can be inserted and deleted using the Insert Row and 

Delete Row command buttons.  Blank lines are not permitted between data.  Similarly, 

blank or zero values mixed with data for two-theta or d-spacing will produce errors 

while calculating or plotting.  The spreadsheet can contain a maximum of 1500 rows. 

 

Sorting Data 

 

   Data can be sorted numerically or alphabetically.  To sort data, pull down the Sort 

menu.  The following options are displayed: 

 

 two-theta - sort two-theta into increasing numerical order 

 d-spacing - sorts d-spacing into increasing numerical order 

 intensity - sorts intensity into decreasing numerical order 

 crystal name - sorts crystal name into alphabetical order 

 

   When an option is selected, data is sorted and displayed in the spreadsheet. 

Hint: 

               If data was entered incorrectly an error will occur.  Check for mixed 

numeric and non numeric data.  
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Calculating Data 

 

   Two types of calculation are possible.  If two-theta’s are known, d-spacings can be 

calculated.  If d-spacings are known, two-theta’s can be calculated using any radiation.  

The correct wavelength must be set before starting a calculation. 

  To set a wavelength, pull down the Calc menu and click Set Wavelength.  A Set 

Wavelength dialog box will appear.  Enter a wavelength in the edit area of the list box 

or select a wavelength from the list.  Click OK to accept the wavelength and return to 

the spreadsheet.  To proceed with the calculation, click: 

 

  d-spacings to calculate d-spacings 

  2-theta to calculate two-theta’s 

 

The calculation proceeds and the results are displayed in the spreadsheet. 

 

 

Printing Data 

 

   Data is printed by pulling down the File menu and selecting Print.  A Print dialog box 

will pop up with several options.  Select OK to print the data.  A simple listing of current 

data will be printed. 

   

Hint: 

               If an error occurs in the calculation, the most likely cause is 

incorrectly entered data.  Check for zero, blank, duplicated or mixed numeric 

and non numeric data. 
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Plotting Digital Scans 
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Plot Scan Options Window 
 

Introduction 

 

   The Plot Scan Options Window sets options to plot a digital scan file XRD. 

File Name to Plot 

 

   Click on the Browse Button to select a scan file to plot.  The following scan file types 

can be plotted: 

 

RRuff *.ruff 

Sietronics *.cpi 

DBW Type *.dat 

ScanPI Type *.dat 

 

Other file types can be plotted by using the file conversion utility in the File Menu or by 

importing a raw file into the spreadsheet and plotting directly from the spreadsheet. 

Set Wavelength 

 

   Click on the Get Button to select a wavelength to use for converting Two-theta to D-

spacings in the Plot Scan Window.  If the scan file contains wavelength information 

then this value will be used.  The wavelength can also changed after the file is plotted 

using the Set Wavelength Command. 

Title 

 

Enter a Title for the Scan Plot here. 

 

Plot From Spreadsheet 

 

   If this option is checked, the current file displayed in the spreadsheet is plotted. 
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Generally, plotting from a file on disk is much faster, however, plotting from a  

spreadsheet is sometimes more convenient when working with imported files. 
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Plot Scan Window 
 

  The Plot Scan Window displays the XRD Scan File on screen with several options 

and controls.  The XRD Scan File can also be printed. 

Plot Scan Commands 

Auto Search Match 

Axes Labels 

Axes Titles 

Box Draw 

Copy XRD 

Extract Peaks 

Fonts 

Grid 

Inset Text 

Labels  

Line Draw 

Print Peak File 

Print XRD 

Quantitative Analysis 

Refine Peaks 

Save XRD As 

Search/Match 

Search Mineral From Database 

Undo 

XRD Color 

XRD Size 

XRD Width 

Zoom 

 

Auto Search/Match Command 

 

  This option performs a Search/Match of the builtin mineral database using the digital 

scan file in the current spreadsheet or Plot Window.  All peak filtering is done 

automatically, no manual adjustment of settings is necessary. A list of matches will be 
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returned to the spreadsheet under the Name column. During the Search/Match, if the 

three strongest d-spacings are found, the mineral will be returned as a match.  If no 

matches are found please check the following: 

 

1. The correct radiation has been entered in the Set Wavelength Option 

2. The spreadsheet columns are defined correctly in the Define Columns Option 

3. D-spacing and Two-theta are formatted correctly in the Format Option 

 

   Use the Accurate Match Option in most cases. This will search the peak file for d1, 

d2 and d3 in any order. This option gives the best results.  If you get zero likely 

matches, use the Expanded Match Option which searches the peak file for d1, d2 and 

d3, but also doubles the search width.  This option will give the most matches, but 

beware, it will most often give false matches. If no likely matches are found, a manual 

search/match will probably be required using the filters available with the Refine Peaks 

and Search/Match Commands. The Auto Search/Match Option may give a large 

number of matches. If this occurs, perform a new search/match of the extracted peaks 

using the Search/Match Command and specifying a narrow search range for d-

spacings. 

 

Axes Labels 

 

   Select this option to change the axes labels font.  A font dialog box pops up for 

selecting the font.    

 

Axes Titles 

 

   Select this option to change the axes title font.  A font dialog box pops up for 

selecting the font.    

Box Draw 

 

   To draw a box, select box draw.  The cursor will change to a cross hair.  Position the 

cross hair where the box is to begin and drag the cursor by holding down the left 

mouse button.  A dotted box is dragged with the mouse.  Release the left mouse 

button when you have positioned the box correctly. 
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Copy XRD Command 

 

   Copies the current XRD to the clipboard for pasting into other applications. 

Delete All 

 

  Deletes all drawing and text actions and redraws the plot 

Extract Peaks 

 

   Extracts peak intensities and two-theta values above a specified intensity  from 2-

theta/Intensity scan files.  Recommended to use the Plot Scan Window to extract 

peaks as this is much faster than importing a scan file into a spreadsheet and 

extracting peaks there. 

 

  Typically, extracting peaks is a two part process.  Peaks are first extracted from the 

scan file using the Extract Peaks Option.  This creates a new spreadsheet or table 

with extracted peaks.  There will be many shoulder peaks from the initial scan file and 

it is necessary to Refine and Filter the Peaks to obtain a final peak file.  Use the Refine 

Peaks Option to filter out shoulder peaks. 

Fonts 

 

   To change the font for inserted text select Fonts.  A Font dialog box is displayed with 

a list of available fonts.  Select a font in the list. 

 

Grid 

 

   Displays a list of Peak values that appear on the XRD.  The peak represented by the 

selected text in the grid will be highlighted. 

Insert Text 

 

   To insert text select Insert Text.  The cursor will change to a cross hair.  Position the 

cursor where you would like to insert text and click the left mouse button.  Type the 

text to be inserted. 
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Labels 

 

   This option determines which labels appear on the XRD.  Select from: 

 

 1.none -  no labels appear on the XRD 

 2.two-theta -  two-theta values 

 3.d-spacing -  d-spacing values 

 4.Intensity -  intensity values 

 5.crystal name -  crystal names 

 6.hkl -  hkl label 

 7. User Defined 

 

Labels can be placed on all peaks or the current selected peak only. 

Line Draw 

 

   To draw a line select Line Draw.  The cursor will change to a cross hair.  Position the 

cursor where you would like the line to begin and drag the line by holding down the left 

mouse button and moving the mouse.  Release the left mouse button when the line is 

positioned correctly. 

 

Print XRD 

 

   Prints the current XRD.  A pop up Print dialog box appears.  Click OK to accept the 

default settings and print the XRD.  If labels are displayed, these will be printed with 

the XRD. If peaks appear to be overlapping, select a smaller scale or use landscape 

orientation.   Full XRD scans print best with landscape orientation and normal size.  

The size and scale of the XRD should be adjusted to give the best result. 

Quantitative Analysis 

 

   This option does a quantitative analysis of selected peaks.  To do a quantitative 

analysis, select the required peaks from the peak table and click on the Quantitative 

Analysis menu item.  A new options window will pop up asking for the background 

value.  Use the automatic setting or enter a background value for the current XRD 
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scan.  The automatic setting can only be used for scans with little background 

scattering; that is, with a relatively uniform background.  Click on calculate to perform 

the analysis.  Peak areas will be calculated using background corrected intensities and 

the result, including percentage, will be displayed in a new window.  Quantitative 

analysis requires a high quality scan to achieve optimum results.  All major peaks for 

the target phase must be selected to get an accurate result. 

Refine Peaks 

  

  This option removes adjacent shoulder peaks from the peak file.  Specify a range for 

adjacent peaks and all adjacent peaks within this range will be deleted.  Use the 

recommended values if you are unsure which values to use.  Typically, extracting 

peaks is a two part process.  Peaks are first extracted from the scan file using the 

Extract Peaks Option to extract peaks above a specified background value.  This 

creates a new spreadsheet with extracted peaks.  There will be many adjacent 

shoulder peaks from the initial scan file and it is necessary to Refine and Filter the 

Peaks to obtain a final peak file.  Use the Refine Peaks Option to filter out adjacent 

shoulder peaks. 

Once the peaks have been extracted and filtered, a Search/Match can be performed.  

You should aim to obtain the strongest 12 peaks for multiphase samples and the 

strongest 4 peaks for single phase samples, in order to perform a search/match. 

 

Save XRD As Command 

 

   This command saves the current XRD in a user specified directory and filename.  A 

pop up dialog box appears which prompts the user for directory path and filename 

information.  Graphics files can be save in bitmap (.bmp) format for exporting into a 

painting program for further editing. 

 

Search/Match Command 

 

  This option performs a Search/Match of the builtin mineral database using the peaks 

in the current spreadsheet.  Specify a d-spacing search range for performing the 

search.  All minerals matching the peak within this search range will be classified as a 

match.  The wider the search range, the more matches obtained.  A list of matches will 

be returned to the spreadsheet under the Name column. During the Search/Match, if 
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the three strongest d-spacings are found, the mineral will be returned as a match.  

Some manual refinement of the results may be required. If no matches are found 

please check the following: 

 

1. The correct radiation has been entered in the Set Wavelength Option 

2. The spreadsheet columns are defined correctly in the Define Columns Option 

3. D-spacing and Two-theta are formatted correctly in the Format Option 

 

  Search/Match is best performed on the strongest 12 peaks for multiphase samples 

and the strongest 4 peaks for single phase samples, otherwise multiple matches may 

be obtained.  Use Refine Peaks Option to filter out adjacent shoulder peaks. 

 

   Use the Accurate Match Option in most cases. This will search the peak file for d1, 

d2 and d3 in any order. This option gives the best results. If you get zero matches, try 

using the Expanded Match Option. This searches the peak file for the any peak that 

matches d1, d2 or d3. This option will give the most matches, but beware, it will most 

often give false matches.  

Search Mineral From Database 

 

   Performs a search of all peaks listed in the Plot Window Data Table and returns a 

match if all three mineral values match the peak values. Select a mineral from the 

database to search for and specify a range. All peaks that fall within the specified 

range are returned as a match. 

 

Title 

 

   Enter a title for the XRD with this option. 

Undo 

 

  To use Undo, first select the drawing action to undo then click on the undo button or 

the undo menu command. 

XRD Color 
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   Select this option to change the XRD Color.  A Color dialog box pops up for selecting 

the Color of the XRD.  Select a Color and click OK. 

 

XRD Size 

 

   Select normal or small to change the default size of the printed XRD. 

Zoom 

 

   To magnify all or part of the plot click on the zoom toolbar button.  Drag the mouse 

over the portion of the plot  to be magnified.  A new window will display the magnified 

image. 
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Plotting Peak Data 

Introduction 

   Data can be plotted as d-spacing vs intensity or two-theta vs intensity stick plots or 

curve plots.  Many options are available to customize the XRD.  Publication quality 

graphs can be produced on a laser printer. 

 

   Before plotting data, several options must be set to control the type and appearance 

of the XRD.  To access the Options window, pull down the Options menu and select 

Set XRD Options. 

 

 

Options Window 

 

   The Options window has many user definable settings to control the XRD. 

 

XRD Type 

 

   This option determines the type of XRD to be plotted.  Select either: 
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 1. two-theta vs intensity 

 

 2. d-spacing vs intensity 

and 

 1.  stick plot 

 

 2.  curve plot 

 

   There is a choice of stick plots or curve plots.  The appearance of the curve plot is 

affected by the scale and size of the plot.   

  

Set Labels 

 

   This option determines which labels appear on the XRD.  Select from: 

 

 1.none -  no labels appear on the XRD 

 

 2.two-theta -  two-theta values 

 

 3.d-spacing -  d-spacing values 

 

 4.Intensity -  intensity values 

 

 5.crystal name -  crystal names 

 

 5.hkl -  hkl label 

 

   Labels can also be added after the XRD has been plotted using the Labels option in 

the Plot window.  Labels allows further control on the placement and type of labels. 

 

Scale Type 

 

   This option determines the type of scale on the XRD.  Select either: 

 

 1. Automatic - automatically calculates the scale using the 
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 minimum and maximum data values. 

 

 2. Manual - allows the user to specify the range of values plotted 

 

Set Scale 

 

   When a manual Scale Type is selected the user must specify the x maximum and 

x-minimum on the XRD.  The user must enter: 

 

 1. XMin - The minimum data value plotted on the x axis 

 

 2. XMax -  The maximum data value plotted on the x-axis 

 

   All values ranging between XMin and XMax are plotted. 

 

Line Width 

 

   Sets the width of sticks on the XRD.  A value between 1 (narrow) and 4 (thick) is 

valid. 

 

XRD Width 

 

   Sets the width of the XRD on the screen.  Select from: 

 

 1. extrawide - XRD width is twice the screen width.  Use the 

 scroll bar to view the XRD.  Use with large data files to prevent 

 crowding of peaks and labels 

 

 2. normal - XRD width is equal to the screen width 

Plot Window 

 

   The Plot window displays the XRD and sends output to the printer or disk.  The Plot 

window contains a menu bar, a graph area, grid list, labels option buttons and 

command buttons.  The XRD contains data sensitive peaks that are linked to a grid list 
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of data.  Each highlighted peak corresponds to a highlighted set of data within the grid.  

A choice of labels can be added to any number of peaks for display on screen or 

output to the printer.  XRD’s can be saved as bitmap (.bmp) graphic files for exporting 

to other applications. 

 

Axes Labels 

 

   Select this option to change the axes labels font.  A font dialog box pops up for 

selecting the font.    

 

Axes Titles 

 

   Select this option to change the axes title font.  A font dialog box pops up for 

selecting the font. 

Box Draw 

 

   To draw a box, select box draw.  The cursor will change to a cross hair.  Position the 

cross hair where the box is to begin and drag the cursor by holding down the left 

mouse button.  A dotted box is dragged with the mouse.  Release the left mouse 

button when you have positioned the box correctly. 

 

Copy XRD Command 

 

   Copies the current XRD to the clipboard for pasting into other applications. 

Fonts 

 

   To change the font for inserted text select Fonts.  A Font dialog box is displayed with 

a list of available fonts.  Select a font in the list. 

 

Grid 

 

   Displays a list of Peak values that appear on the XRD.  The peak represented by the 

selected text in the grid will be highlighted. 
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Insert Text 

 

   To insert text select Insert Text.  The cursor will change to a cross hair.  Position the 

cursor where you would like to insert text and click the left mouse button.  Type the 

text to be inserted. 

 

Labels 

 

   Determines the type of label to display on the XRD.  Choose from: 

 

 1. clear labels - clears all labels on the current XRD 

 

 2. two-theta - the current two-theta value is plotted 

 

 3. d-spacing - the current d-spacing value is plotted 

 

 4. intensity - the current intensity value is plotted 

 

 5. crystal name - the current crystal name is plotted.  The full 

 crystal name is plotted. 

 

 6. hkl - the current hkl value is plotted 

 

   To display a label, click a row in the grid.  The peak corresponding to the row will be 

highlighted on the XRD.  Now click on the label button to display the label for the 

highlighted row.  Repeat the procedure to display labels for other peaks.  When Print 

XRD is selected, labels will be printed with the XRD.  Greater control for plotting labels 

is available with the Labels command in the Options Menu. 

 

Line Draw 

 

   To draw a line select Line Draw.  The cursor will change to a cross hair.  Position the 

cursor where you would like the line to begin and drag the line by holding down the left 

mouse button and moving the mouse.  Release the left mouse button when the line is 

positioned correctly. 
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Log Scale 

 

   Click this option to change between log linear and linear scales.  Only available for 

stick plots. 

 

Search/Match Command 

 

  This option performs a Search/Match of the builtin mineral database using the peaks 

in the current spreadsheet.  Specify a d-spacing search range for performing the 

search.  All minerals matching the peak within this search range will be classified as a 

match.  The wider the search range, the more matches obtained.  A list of matches will 

be returned to the spreadsheet under the Name column. During the Search/Match, if 

the three strongest d-spacings are found, the mineral will be returned as a match.  

Some manual refinement of the results may be required. If no matches are found 

please check the following: 

 

1. The correct radiation has been entered in the Set Wavelength Option 

2. The spreadsheet columns are defined correctly in the Define Columns Option 

3. D-spacing and Two-theta are formatted correctly in the Format Option 

 

  Search/Match is best performed on the strongest 12 peaks for multiphase samples 

and the strongest 4 peaks for single phase samples, otherwise multiple matches may 

be obtained.  Use Refine Peaks Option to filter out adjacent shoulder peaks. 

 

   Use the Accurate Match Option in most cases. This will search the peak file for d1, 

d2 and d3 in any order. This option gives the best results. If you get zero matches, try 

using the Expanded Match Option. This searches the peak file for the any peak that 

matches d1, d2 or d3. This option will give the most matches, but beware, it will most 

often give false matches.  

Search Mineral From Database 

 

   Performs a search of all peaks listed in the Plot Window Data Table and returns a 

match if all three mineral values match the peak values. Select a mineral from the 

database to search for and specify a range. All peaks that fall within the specified 
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range are returned as a match. 

 

Set Scale 

 

   This option changes the d-spacing or two-theta scale.  Enter new minima and 

maxima and click OK to plot the new scale. 

 

Set Wavelength 

 

   This option changes the default wavelength for calculating two-theta and d-spacings. 

 

XRD Color 

 

   Select this option to change the XRD Color.  A Color dialog box pops up for selecting 

the Color of the XRD.  Select a Color and click OK. 

 

XRD Size 

 

   Select normal or small to change the default size of the printed XRD. 

 

XRD Type 

 

   Change between d-spacing or two-theta vs intensity XRD’s with this option. 

 

XRD Width 

 

   This option changes the width of the XRD between normal and extrawide width.  

Only available for on screen display.  XRD’s are displayed best with extrawide width.  

Use the XRD Size option to change the size of the printed XRD.   

 

Title 

 

   Enter a title for the XRD with this option. 

Undo 
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  To use Undo, first select the drawing action to undo then click on the undo button or 

the undo menu command. 

 

 

XRD Database 
 

 

   The MinServ XRD Minerals Database contains XRD data on all minerals.  Over 

3700 minerals with mineral name, three strongest d-spacings and intensities, chemical 

formula and crystal system are listed. 

Using the XRD Database 

 

  The XRD Database has all entries indexed by mineral name and d-spacing and is 

displayed in tabular format.  The table can be browsed using scroll bars. To perform a 

query, enter the search terms in the search option boxes.  Mineral name and d-

spacing can be searched and d-spacing search limits can be entered or selected.   

 

Important: Search limits must be entered for d-spacing searches.  In most cases, a 

narrow search pattern will give the most accurate results. If the XRD peaks are 

uncertain, perform a wider search, by specifying a wider d-spacing range. 

 

   Click on Search to perform the search.  A list of matches is shown in the main 

window.  Scroll through the minerals to see each record that matches the query.  The 

results may be printed.  The database can be sorted according to mineral name or d-

spacing from the Edit Menu and all data can be printed. 

 

   This database is editable. Enable editing by selecting Edit Database, then Enable.  

Once the edit mode is enabled, any changes made to the database should be saved 

by using the Save Command or clicking on the Refresh Button. A new record can be 

entered by selecting Add New Record.  A new record with empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is 

desired under a specific property then enter "Empty" for that specific property. Default 

values for all properties are "Empty".  This word is automatically added to new entries. 
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   More information can be displayed on a mineral by clicking on the More Info button.  

The mineral name, formula and crystal system are displayed, if this information is 

available. If not, information can be added by using the Edit Menu. 
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Software Support 
   
 
 Technical support for XRDCalc is provided through the printed manual and online 

help.  Updates can be obtained free of charge using the builtin ftp update program.  If 

an insurmountable problem occurs further technical support is available directly from 

Mineral Services; however, the software must be registered to receive support.   

 

                    MinServ (Mineral Services) 

                    email: support@geologynet.com 

                    http://www.geologynet.com 
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